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1. Release Notes 

1.1 Background / Environment 

Oracle Financial Services Software Limited has developed Oracle Financial Services Lending and 

Leasing solution. The suite is a comprehensive, end-to-end solution that supports full lifecycle of 

direct and indirect consumer lending business with Origination, Servicing and Collections modules. 

This enables financial institutions to make faster lending decisions, provide better customer service 

and minimize delinquency rates through a single integrated platform. It addresses each of the 

lending processes from design through execution. Its robust architecture and use of leading-edge 

industry standard products ensure almost limitless scalability. 

1.2 Purpose 

The purpose of this Release notes is to highlight the enhancements and bug fixes included in the 
Oracle Financial Services Lending and Leasing Release. 

1.3 Abbreviations 

Abbreviation Detailed Description 

OFSLL Oracle Financial Services Lending and Leasing 

XML Extensible Mark-up Language 

XSD XML Schema Definition 

GL General Ledger 

XLF Extended Log Format 

JSF Java Server Faces 

EAR Enterprise Application Archive 

UI User Interface 

WSDL Web Services Description Language 

ACH Automated Clearing House 

MDB Message Driven Bean 

JMS Java Messaging Service 

IoT Internet of Things 

UDF User Defined Fields 

UDP User Defined Parameters 
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Abbreviation Detailed Description 

TXN Transaction 

OBRH Oracle Banking Routing Hub 

ML Machine Learning 

1.4 Product Summary 

Oracle Financial Services Lending and Leasing Release built to meet various challenges faced by 
financial institutions. It addresses each of the lending processes from design through execution. Its 
unique value lies in its ability to provide the business with predefined processes and an excellent 
framework that takes care of business risk and compliance needs. 

1.5 Release Highlights 

The key highlight of this release is to fix the critical bugs and to enhance the industry specific 
requirements. 
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2. Enhancements 

 

Enhancement Description 

Functional Enhancements 

Table Columns as 
Event Action 
Parameters 

Since all the UDF parameters and all account fields are in EVENTS, a 
provision is given to enable configuring events based on the parameters. 

Customer No. & 
National Id in servicing 
quick search 

In Servicing > following new Quick Search Parameters are provided; 
Customer No. and National ID. 

Machine Learning - ML 
Data set creation 
through batch job 

As part of Machine Learning enhancements - ML Data set creation is 
possible through batch job. 

Metro II enhancement 
J1 AND J2 SEGMENT 

Metro II reporting has been enhanced such that if address of primary and 
spouse / any other relation is same, then system reports J1 segment while 
generating metro II file instead of reporting data in J2 segment. 

Implementation of 
OBRH (Oracle Banking 
Routing Hub) in OFSLL 

OFSLL supports integration of OBRH (Oracle Banking Routing Hub). 

Copy feature in Criteria 
based condition and 
Servicing Queue 
Screens 

Provided a Copy feature in ‘Criteria Based Condition’ setup screen and in 
Servicing Queue screens. 

‘Accrual Start Dt’ 
Change Transaction 

New Transaction has been introduced to Change Accrual Start Date. 

'Asset Primary 
Indicator' flag in sales 
tax setup - Vertex 
Integration 

'Asset Primary Indicator' flag has been introduced in sales tax setup - Vertex 
Integration. 

Queue for accounts 
with ‘No Condition’ 

System now has the ability to create Queue for accounts with ‘No Condition’. 

Agreement Structure A facility has been provided to capture Agreement Number in Account to help 
grouping of specific accounts maintained in the system. 

Sales Order A facility has been provided to capture Sales Order number in Account to 
help grouping of specific accounts maintained in the system. 

Asset Attributes New Asset Attributes are added to capture additional details in collateral 
screen. 

Copy existing Bureau 
report 

There is a provision to copy Bureau of existing customer based on system 
parameter. 
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Enhancement Description 

New Bureau 
parameters 

Following two new Credit Bureau parameters - Model ID & Score Number is 
added to 'Cred Summary' table and also added to base Bureau table. 

New Queue Selection 
Parameters 

'Day of a week' parameter is introduced in Setup > Customer Service 
Queues. 

Decision EDITS Auto validation Edits have been introduced to fields such as First name, 
DOB, SSN compare with bureau first name EDIT 

Application Status 
Change validations 

System can now Restrict / allow explicitly if the same user or responsibility to 
change the application status. 

Lease - Amortization 
Schedule Method 

New calculation method called ‘Amortized’ with fixed repayment schedule 
introduced for Lease. 

Monthly Amortization 
for Lease 

Facility to amortize Interest/Rent balance of Lease on monthly basis using 
Scheduled Based method, irrespective of billing cycle (Say Quarterly, Annual 
etc.,) introduced for lease. 

Web Services Enhancements 

Account GET Service Producer Number as account search parameter - WS 

Data Access in 
Webservices 

Data Access in Webservices can now be controlled based on company 
and branch. 
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2.1 Table Columns as Event Action Parameters 

2.1.1 Overview 

 In device financing, OFSLL is expected to support different promotional offers (example 
Buy one and get one, Buy one and get another phone for 50%). 

 For promotions that are not supported in base/implementation, specific idea is to use 
OFSLL Events Framework to achieve these business cases. 

 To support these features, below enhancements are introduced in OFSLL 

 System is designed to have the ability to input Table > Column Value as Event 
Action parameters. 

2.1.2 Description 

Following changes are done to Entity-Event-Action Types: 

Entity Type Event Type Actions 

Accounts All Event Types for entity ‘Accounts’ 1. Post Comment 

2. Post Monetary Txn 

3. Post Non-Monetary Txn 

2.1.3 Column Value as User Defined Table Parameters 

 OFSLL supports Event Criteria definition using User Defined Table for different Events. 

 These Criteria are enhanced to join different tables. For example, Account Condition 
Create Event can have Criteria parameters of ACCOUNT_CONDITIONS and 
ACCOUNTS Table using different User Defined Tables and single User Defined Table 
Type as given below. 

 A new set of User Defined Tables and Table Types are created with default values 
similar to existing criteria parameters. 

 New Table types also supports joining of tables similar to criteria parameters. 

 These parameter can be used to provide values for Event Actions. 

 A new Value Type > COLUMN VALUE is added in Action Parameters, to allow users to 
select values from new User Defined Tables. 

 If the column value cannot be populated due to multiple records or if no record found, 
system leaves the parameter value as unchanged/blank. 
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2.1.4 Seed Data 

Refer ‘Appendix: Seed Data’ chapter. 
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2.2 Customer # & National Id in Servicing > Quick Search 

2.2.1 Overview 

Customer # and National ID parameters added in Servicing > Quick Search. 

2.2.2 Description 

 Servicing > Quick Search has following new search parameters; Customer # and 
National ID. 

 If multiple records exist for the input, system shows the standard error message as 
‘Multiple Matches found for the National ID, Please use normal Search’. 

 

2.2.3 Seed Data 

Refer ‘Appendix: Seed Data’ chapter. 
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2.3 Machine Learning - Data Set Creation through Batch 

2.3.1 Overview 

Currently, the Machine Learning data set is not configurable. A new batch job is created to load 
ML data set which is the input for cluster creation. 

2.3.2 Description 

 It is assumed that the parameters considered for cluster creation is static. 

 Following batch job is created to load ML data set which is the input for cluster creation - 
QMLPRC_BJ_100_03 ML DATASET CREATION FOR INTELLIGENT SEGMENTATION 

 For data, system refers the respective columns from User Defined Tables. 

2.3.3 Seed Data 

Refer ‘Appendix: Seed Data’ chapter. 
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2.4 Copy feature in Servicing & Criteria Based Condition 

2.4.1 Overview 

Copy feature in provided in Setup to ease the use of Servicing Queues and Criteria Based 
Condition screens. 

2.4.2 Description 

Setup > Queues > Servicing: 

 Introduced 'Create Copy' feature with access key. 

 On Click of Copy, system copies the header and Child tabs as follows (however, Group 
Assignment Tab & Group Activity – Doesn't get copied). 

 Selection Criteria 

 Sort 

 Responsibilities and Users 

 Data Node Assignment 

 'Copied' records are created with 'Enabled' = N; both parent and child records. 

Setup > Queues > Criteria based Condition 

 Introduced 'Create Copy' feature with access key. 

 On Click of Copy, system copies the header and Child tabs as follows: 

 Criteria Details 

 Conditions 

 'Copied' records are created with 'Enabled' = N; both parent and child records. 

 

2.4.3 Seed Data 

Refer ‘Appendix: Seed Data’ chapter. 
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2.5 Facility to define and change Accrual Start Date 

2.5.1 Overview 

 OFSLL is enhanced with a facility to capture ‘Start Date’ from which interest accrual 
would be calculated. 

 This date can be configured in Origination and can be changed in Servicing (before bill 
generation). 

2.5.2 Description 

Changes in Setup > Contract > Lease (Interest Rate Method) 

 Currently the ‘Start Date Basis’ for Lease is supported for ‘Effective Date’ only. 

 System shows the LOV with reference to ‘ACCRUAL_START_DT_BASIS_CD 
(ACCRUAL START DT BASIS CODES) for selection (Refer Figure 2). 

 If user selects the ‘Payment Date, system calculates the interest from ‘Payment Date 
– 1 Cycle’. 

 If user selects the ‘Effective Date, system calculates the interest from ‘Contract Date’. 

Example: Contract Date = 01 Jan 2021; First Payment Date = 01 April 2021 

Results: 

Effective Date (Contract Date) 01 Jan 2021 

Start Days 5 

Accrual Start Date 05 Jan 2021 

 

Payment Date (Payment Date -1 Cycle) 01 April 2021 

Start Days 5 

Accrual Start Date 05 March 2021 

Changes in Origination > Contract > Loan/Lease 

 Loan - On ‘Load Instrument’, currently system displays the ‘Start Date Basis’ and ‘Start 
Days’ as Read Only fields. 

 Lease - Currently ‘Start Date Basis’ for Lease is supported for ‘Effective Date’ only. 

 System shows the LOV with reference to ‘ACCRUAL_START_DT_BASIS_CD 
(ACCRUAL START DT BASIS CODES) for selection. 

 Fields are re-arranged as shown in below image and made it editable for user input 
during origination stage. 

 These parameters are added in ‘Account On boarding’ and ‘Application Contract’ web 
service > Loan & Lease. 
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 If User explicitly adds the fields (in Servicing) information in Servicing is considered. 

 If tags are not filled, information at contract level is considered. 

Changes in Calculator  Contract Level & Stand Alone  Loan / Lease 

Contract Level: 

 Currently, while generating the ‘Schedule’ system does not consider the ‘Start Date’ basis 
and Start Days while charting the loan amortization schedule. 

 After this change, system considers these values while charting the loan amortization 
schedule. 

Stand-alone Calculator: 

 Accrual Start Dt Basis and Accrual Start Days fields are enabled for user input. 

 System considers these values while charting the loan/lease amortization schedule. 

Validations for Origination Calculator & Standalone calculator: 

 If user selects ‘Contract Date Basis (Effective Date)’, system calculates the interest from 
‘Contract Date + Start Days. 

 System validates that ‘Start Days’ + Contract date less than first payment date. 

 Above validation is applicable for Loan & Lease. 

 If user selects the ‘Payment Date’, system calculates the interest from ‘Payment Date – 1 
Cycle. 

Changes in Servicing  New Monetary transaction 

New Monetary transaction is introduced to adjust accrual and first payment date. 

 CR_FIRST_PMT_DT_CHANGE - accrual and first payment date change 

 ACR_FIRST_PMT_DT_CHANGE_REV > reverse accrual and first payment date change 

Transaction Parameters: 

Parameter Code Default Sort Displayed Required Comments 

Txn Date System Date 0 Y Y  

Accrual Start 
Date 

GL Date 1 Y Y Should be greater than 
contract date. 

First Payment 
Date 

 2 Y Y Should not be less than 
‘Accrual Start Date’ 

Validations: 

System allows to post the transaction on validating the following points or shows error message. 

Validation Error Message / Comment 

‘Start Date’ date (User Input / Derived) 
should be greater than contract date 
and less than or equal to First 
Payment date. 

‘Start Date’ should be greater than contract date. 
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Validation Error Message / Comment 

‘First Payment Date’ should not be less 
than ‘Accrual Start Date’. 

First Payment Date’ should not be less than ‘Accrual 
Start Date’. 

Note: System doesn’t validate the Due date Max and 
user is expected to input this value considering the 
business use case. 

This Transaction is allowed to post on 
account, where there is ‘No Billing, no 
Transactions’ other than Active 
Transaction posted on account.  

Validation: 

a. If acc_accrual_dt_start = 
acc_accrual_dt_last – No accrual 
happened yet 

b. If acc_due_dt_next = 
acc_first_pmt_dt – No billing happened 
yet 

Transaction cannot be posted, as accrual / 
transaction posted on account. 

Transaction not allowed to post for 
Rent collection method = ADVANCE 
and if user tries to post on account with 
specified collection method, show error 
message 

Transaction is allowed to post for Rent collection 
method ‘Arrears’. 

Actions on posting of transaction: 

If the transaction posting is successful: 

 If any interest is already accrued till date, system passes negative interest transactions to 
negate the amount to ZERO. (The reason to pass negative interest transactions is to 
negate ‘Daily Amortized’ interest GL). This step resets the accrued interest amount to 
Zero. 

 Following information is re-calculated: 

 Maturity date is adjusted according to new payment date (if different payment is 
selected). 

 Due Date Next, Due Day, Repayment Date, Late charge date gets realigned based 
on new payment date. 

 There is no impact on the delinquency, bill amount. Only the final bill amount differs. 

 System displays the following message: 

 Transaction Posting Successful 

 Old Accrual Start Date: 02/01/2020 and First Payment Date: 03/01/2020 

 New Accrual Start Date: 03/01/2020 and First Payment Date: 04/01/2020 

If the transaction posting is not successful: 

 Shows valid error message as mentioned in the table above. 
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Figure 1 (Loan & Lease Origination Screen) 

 

Figure 2 (Setup  Lease Contract) 

 

Figure 3 (Loan/Lease Calculator): 
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Figure 4 (Servicing  Account Information Show ‘First Payment Dt’ 

 

2.5.3 Seed Data 

Refer ‘Appendix: Seed Data’ chapter. 
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2.6 Copy Existing Customer Bureau Pull to New Application 

2.6.1 Overview 

When an existing customer with recent credit bureau applies for Loan/Line/Lease, there is a 
provision provided to link the Existing Credit Report to new application and use for Underwriting 
and Scoring and Pricing. 

The change is applicable for Applicant and Business bureau pull. 

2.6.2 Description 

 Currently, in OFSLL > Servicing, subsequent bureau pull is based on the system 
parameter > DAYS_TO_PULL_CRB_REPORT (SET MINIMUM DAYS TO PULL CRB 
REPORT FROM SAME BUREAU FROM INITIAL PULL). 

 The use of this parameter is extended to origination stage also, to guide the system 
whether the bureau pull is required or not. 

 Web Services: Application Entry & Simple App Entry Web services→ Introduced new tag 
'Copy Bureau Request' and this refers to new lookup and accept values based on the 
lookup. Behaviour of 'Copy Bureau Request' is derived based on value N, C as 
explained. 

 Following screen level changes are taken in Application screen. Added new field below 
'Copy Bureau Request'. This field will be enabled only if the CRB Pull flag = Y. 

 

Field Name Mandatory Validations 

Copy Bureau 
Request 

Y This field is enabled, only if 'CRB PULL' flag value = Y 

This field is an LOV with two values: 

None 

Copy Latest 

On selection, of 'Copy Latest' system instead of pulling the new 
bureau report, will copy the bureau report; if available with in 
time frame as configured in system parameter. 
(DAYS_TO_PULL_CRB_REPORT - SET MINIMUM DAYS TO 
PULL CRB REPORT FROM SAME BUREAU FROM INITIAL 
PULL) 
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If no bureau report is available with in time frame configured in 
system parameter; system will automatically trigger new bureau 
pull. 

Change the field property as lookup with following values w.r.t new lookup 

Lookup Type Description System Defined Enabled 

COPY_CRB_REQUEST_CD COPY CREDIT BUREAU 
REQUEST CODES 

Y Y 

 

Lookup Type Description Action 

N None System does not pull the bureau details. User is expected to 
do the bureau pull manually during decision stage. 

C Copy Latest System copies the bureau details to new application, if the 
'Existing Customer Id' is not NULL and 'Update Customer Info' 
flag = Y at applicant level. 

 Multiple Applicants and Multiple Credit Bureau Pulls  

 The behavior is same for One or multiple applicants i.e., bureau pull happens for 
multiple or joint applicants. 

 For an application, if multiple bureau pulls are done Eg: Equifax and Transunion; 
behavior would be as follows: 

 Final Action → 'Copy' in the following example is new behavior 

 Final Action → 'Submit' in the following example is existing behavior. 

 

2.6.3 Seed Data 

Refer ‘Appendix: Seed Data’ chapter. 
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2.7 Store unparsed Acro File Risk Scoring Model Segment 

2.7.1 Overview 

If customer subscribes to Model Number 02875 [Probability Scale], Equifax (EFX) Risk Score 3.0 
model contained in Market-Max segment of FULL FILE FIXED / ACROFILE PLUS PRINT IMAGE 
COMBO REPORT from Equifax (EFX). 

In this segment, system reads the Model Id/Score Card and Score Number however, it is not 
shown to user.  

2.7.2 Description 

 With this change, system reads the Model Id/Score Card and Score Number. 

 These values are now stored as data elements and available for scoring. 

 System stores the data in 'CRED_DATA_POINT_SCORES' and CRED_SUMMARY' table. 

 Shows it in 'Credit Scores' tab alone 

Note: storing into 'CRED_SUMMARY' is based on the BUREAU_SCORE_MODEL_CD's sub 
code. I.e., however, system stores the CUM_FICO_SCORE and CUM_BKRP_SCORE, in the 
same way, it should store these two elements also. 

 

2.7.3 Seed Data 

Refer ‘Appendix: Seed Data’ chapter. 

 

  



                                                                              2-16 

2.8 'Day of a Week' Parameter in Customer Service Queues 

2.8.1 Overview 

 Certain US states has regulation to restrict to call customers on the specified days only. 

 To support this, following changes are taken up: 

 Provided a configuration that Dialer file generates in allowed days so that, Bank can 
hand over the Dialer File only on specified days. 

 'Day of a week', added as new parameter to handle queue that can be taken up 
Manually or through Auto-Dialer. 

2.8.2 Description 

A new set of parameter group introduced that is predefined as per the documented behaviour 

Parameter 
Code 

Description Applicable 
codes in criteria 

Behavior 

Current_Day Day of a 
week 

MO,TU,WE,TH,F
R,SA,SU, ALL 

 

While executing the SET > QCS > 
QCSPRC_BJ_100_01 batch, Based 
on the values configured in the Setup 
> Queues > Customer Services > 
Selection criteria: 

 System identifies the Day of 
the System. 

 Matches the Criteria Values 
in combination of 
Comparison Operate. 

If both 1 & 2 matches, then the set of 
accounts are qualified for this queue 

 

Example: In selection criteria, following are the different ways that user configured and how 
system behaves: 

# Parameter Day of 
system 
date 

Comparison 
Operator 

Criteria 
Value 

Operator Result 

1 Day of a 
week 

Monday 
(1st 
Nov'21) 

Like ALL AND System generates the 
queue all the time with 
combination of 
account are having 
delq more than 30days Delq Days  Greater 

Than 
30  

2 Day of a 
week 

Monday 
(1st 
Nov'21) 

EQUAL MO AND 
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# Parameter Day of 
system 
date 

Comparison 
Operator 

Criteria 
Value 

Operator Result 

Delq Days  Greater 
Than 

30  System generates the 
queue & with 
combination of 
account are having 
delq more than 30days 
- because system day 
is MONDAY and 
criteria is set it as MO. 

If system date is 
'Tuesday (2nd 
Nov'21), then queue 
should not build queue 

3 Day of a 
week 

Monday 
(1st 
Nov'21) 

IN ('MO','W
E','FR') 

AND System generates the 
queue & with 
combination of 
account are having 
delq more than 30days 
- because system day 
is MONDAY and 
criteria is matches with 
MO 

Also, if system date is 
'Wednesday (3rd 
Nov'21) or 'Friday (5th 
Nov'21), then also 
queue should build 

If system date is 
'Tuesday (2nd 
Nov'21), then queue 
should not build queue 

Delq Days  Greater 
Than 

30  

Note: Exiting validations of comparison operator which are applicable for var-char is extended to 
this also 

Example: Setting up of Queues using comparison operators for VARCHAR2 datatype can 
adversely affect the performance of the system or IS is not applicable etc. 

2. In origination, to derive Due Day for weekly billing, we treat Sunday = 1, Monday = 2.... 
Saturday = 7 

Maintenance Changes 

Provided a new User Defined Table as follows: 

Parameter Value 

Description CUSTOMER SERVICE QUEUE PARAMETERS: SYSTEM 

Product Type All 



                                                                              2-18 

Parameter Value 

Funding Type 

Collateral Type 

System Defined Yes/No No 

Table QUE_CS_SYSTEM 

User table Type QUEUE : CUSTOMER SERVICE 

Provided below User Defined Table Attributes to above table: 

Parameter Value 

Attribute Current Day 

User table Type Day of a week 

Data Type Varchar 

Length 30 

Operator Like 

System Defined Yes/No No 

2.8.3 Seed Data 

Refer ‘Appendix: Seed Data’ chapter. 
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2.9 EDITs to compare 'Name/DOB/SSN' with 'Bureau Report' 

2.9.1 Overview 

A facility is provided in Origination EDITS to raise an EDIT comparing Name in application and 
Name in the bureau. 

2.9.2 Description 

Introduced decision EDITS to compare First Name & Last Name in application and Credit Bureau 
Report → APPLICATION APPROVAL EDITS 

Edit Sub Type Edit Result 

ORIGINATION 
DECISION 

XVL : PRIMARY APPLICANT FIRST NAME OR LAST 
NAME IN APPLICATION NOT SAME AS  APPLICANT 
FIRST NAME OR LAST NAME IN BUREAU REPORT 

Error 

ORIGINATION 
DECISION 

XVL : PRIMARY APPLICANT SSN  IN APPLICATION NOT 
SAME AS SSN MENTIONED IN BUREAU REPORT 

Error 

ORIGINATION 
DECISION 

XVL : PRIMARY APPLICANT DOB IN APPLICATION NOT 
SAME AS DOB MENTIONED IN BUREAU REPORT 

Error 

 In case of multiple bureaus, system refers 'Value' in EDIT configuration field. Example: If 
'EXP' (EFX, TUC, CSC) is maintained in the EDIT value, system compares the 
application values with Experian. 

 If this value is not maintained, system refers the bureau selected in the decision stage. 

 If no bureau data is available or bureau preference is not selectable by the system, EDIT 
would not be fired. 

2.9.3 Seed Data 

Refer ‘Appendix: Seed Data’ chapter. 
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2.10 Status Change by different User/ Responsibility 

2.10.1 Overview 

Following use cases are handled with this change: 

 Use Case 1: Financial Institute/Lender does not want the same user or same 
responsibility to perform 2 subsequent cycle changes, while processing an application. 

Example: If a user with responsibility of a Funding manager, changes the status of the 
application from 'Approved- Final doc check' to 'Approved-Verified', then the same user 
cannot perform the status change from 'Approved - verified' to 'Approved -Funded' for the 
same application. 

 Use Case 2: Financial Institute/Lender want the same user or responsibility to perform 
subsequent cycle changes, while processing an application. 

Example: If a user with responsibility of a Funding manager, changes the status of the 
application from 'Approved- Final doc check' to 'Approved-Verified', then the same user 
has to perform the status change from 'Approved - verified' to 'Approved -Funded' for the 
same application. 

2.10.2 Description 

Applicability of Changes: Loan, Lease, Line → Setup Cycles 

 Provided a new lookup for ‘Status Change Validation’ (Refer Fig below). 

 The lookup consists of following options: 

 None → If this option is selected, system does not validate for User / Responsibility, 
while making status change (This is the default seed data value, which retains the 
existing behavior). 

 User - Same→ If this option is selected, system validates for the same User, while 
making the status change. (Verify past 1/2/n records based on lookup subcode 
configuration for User) 

 User - Different→ If this option is selected, system validates for the different User, 
while making the status change. (Verify past 1/2/n records based on lookup sub-code 
configuration for User) 

 Responsibility- Same→ If this option is selected, system validates for the same 
Responsibility of the Current User with Responsibility of Previous Status change 
User, while making the status change. (Verify past 1/2/n records based on lookup 
sub-code configuration for Responsibility) 

 Responsibility- Different → If this option is selected, system validates for the 
different Responsibility of the Current User with Responsibility of Previous Status 
change User, while making the status change. (Verify past 1/2/n records based on 
lookup sub-code configuration for Responsibility) 

NEW SYSTEM EDIT (Shown under 'Verification Tab): 

For User-Same / Responsibility-Same: 

If the different user/ same responsibility is trying to change the status; where the configuration is 
enabled; system raises EDIT / service result as follows: "User/Responsibility must be same 
between current and previous status change ". (EDIT type = Error) 
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For User-Different/ Responsibility-Different: 

If the same user/ same responsibility is trying to change the status; where the configuration is 
enabled; system raises error EDIT/ service result as follows: "User/Responsibility must be 
different between current and previous status change". (EDIT type = Error). 

Exceptions: 

In case the responsibility of the user changed from X to Y, system doesn't validate the use case 
and expected to handle operationally (Note: We can validate User & Responsibility to handle the 
scenario; but considering this as exception; the proposal is to validate only the responsibility). 

Created a new Lookup as following: 

 Lookup Code: STATUS_CHANGE_VALIDATION_CD 

 Lookup Description: Status Change Check 

 System Defined: Yes 

 Following Lookup Codes are provided 

 Value in the sub-code (Other than NULL) indicates the number of past status records 
to verify for unique check → User/ Responsibility validation. 

Lookup Code Description Sub-code 

NONE NONE  

USE_SAME User - Same 1 

USR_DIFFERENT User - Different 1 

RSP_SAME Responsibility - Same 1 

RSP_DIFFERENT Responsibility - Different 1 

Notes:  

 For User Same/ Responsibility Same, Ideal definition of sub code = 1. 

 System validates the user/ responsibility as configured at the cycle level, while changing 
the status using webservice → Change Application Status Service. 
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2.10.3 Seed Data 

Refer ‘Appendix: Seed Data’ chapter. 
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2.11 Lease – Amortized Method of Calculation 

2.11.1 Overview 

Exiting version of OFSLL supports – Rent Factor and Interest Rate Method. 

US region has 'Fixed Amortization' Schedule of business practices, where the repayment 
schedule of lease is pre-defined / fixed at the beginning of the lease and no subsequent changes 
would be done to lease payment until the maturity date or extension of lease at the end of lease 
period. 

OFSLL is enhanced to support the Lease 'Amortized' method as follows: 

 Support 'Amortized Lease Schedule method including handling impact in the modules 
like Setup, Origination and Servicing including calculators + Account On boarding 
service. 

 Support Rent Collection Method = Advance & Arrears 

2.11.2 Description 

To support Amortized method, following changes are taken up in the product: 

Setup Changes: 

‘Product’ Setup  

Following changes taken in Setup →  Product →  Lease Product Tab 

 Add new value called 'Amortized' the lookup → CALC_METHOD_CD (CALCULATION 
METHOD CODES). 

 This will show the value in 'Calculation Method' under 'Calculator Parameters' of Product 
setup. 

 

‘Pricing’ Setup Changes 

Shows the value 'Amortized' for Calculation method field and disable 'Promotion' field for 
selection. 
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‘Contract’ Setup Changes 

 New calculation method - Amortized is shown for selection. 

 Introduced new field called 'Lease Recovery Type' with options called Fixed and 
Proportionate. 

Calculator Changes: 

Origination & Standalone Calculator: 

 When user selects the method called 'Amortized': 

 The amortized schedule generated in origination is fixed and not impacted by late 
payments. 

 Flexible repayment schedule with Type = User Defined' allows for user input. (Other 
options are not enabled for current scope). 

 System calculates the rate based on the payment amount input. 

 Repayment Schedule generated in the calculator is stamped in Servicing > Repayment 
Schedule tab and due date history is generated based on the defined schedule. 

Payment Scenarios: 

 No additional interest would be calculated, even if the customer is not paying the bill 
amount on due date and subsequent bills are generated based on the schedule. 
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Lease Termination & End of Lease Handling: 

 System supports lease termination with and without buyout. 

 User can post 'Extension' or Ever green lease transactions to extend the lease. (Note: 
Extension is allowed on lease, only at the end of term of lease). 

 Lease will continue the nature of amortized, after posting of extension or evergreen 
transaction. 

2.11.3 Seed Data 

Refer ‘Appendix: Seed Data’ chapter. 
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2.12 Vertex upgrade to v9.0 

2.12.1 Overview 

OFSLL supports the recording and calculation of Sales and Usage Tax for Lease contracts / 
applications / accounts. 

Following enhancement are introduced in OFSLL: 

 Vertex v9.0 Support (HTTPS) 

 Option to choose assets for Sales Tax Calculation 

2.12.2 Description 

Setup changes to support Vertex v9.0  

Introduced a new system parameter so that the system has the ability to determine Vertex URL 
endpoint provided is v8 or v9. The system parameter “VTX_VERSION - VERTEX VERSION’ can 
hold two values  

Parameter Value Comment 

V8S Users need to maintain the Vertex 8.0 URL under the 
VTX_OUTBOUND_URL system parameter 

V9S Users need to maintain the Vertex 9.0 URL under the 
VTX_OUTBOUND_URL system parameter 

Note: For the system to work correctly, it is mandatory to enable the VTX_VERSION parameter 
and maintain the proper value. 

Restricting Assets for Sales Tax Calculation 

 Currently OFSLL supports the restriction of Sales Tax calculation only for the primary 
asset 

 Now, it extended to identify if Tax is to be calculated for all the Assets or Primary only 

 Added a ‘Compute Sales Tax’ indicator at Collateral (in origination, servicing, & 
collections) to indicate if Sales Tax calculation is applicable or not 
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 Suppose an account/application has multiple assets, and the User enabled ‘Compute 
Sales Tax’ for any one of the assets. In that case, system passes that specific set of 
collateral information only. 

 If the User is not selected for any of the Collateral, system passes primary asset 
information only by default. 

 The default value of this flag is ‘N’. 

2.12.3 Seed Data 

Refer ‘Appendix: Seed Data’ chapter. 
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2.13 New Amortization Method (Every Month End) 

2.13.1 Overview 

In the US, Lease amortization (accounting of accrued interest) is done on a monthly basis, 
irrespective of the billing cycle of the account, using Scheduled Based amounts. 

For example, Billing Cycle > Statement to the customer could be issued Quarterly, but the 
accrued interest handover of GL happens monthly. 

OFSLL is required to support amortization using the predefined schedules. 

2.13.2 Description 

Setup Changes 

 Introduced a new ‘Amortization Method’ under Setup > Contract > Lease: 

 Int Amortization Freq > ‘EVERY MONTH END’ 

 Amortized Balances > Amortization Method as 'SCHEDULED BASED (Month End 
Only)' 

 While saving the record under ‘Amortized Balances’ with this new Int Amortization Freq, 
system validates the following: 

Filed Reference Error to display 

Cost/Fee Method' should be NONE; if not 
selected as NONE, then 

The amortization Cost/Fee indicator should be 
NONE 

Setup → Contract → Lease → Contract 
Definition → View → 'Int Amortization Freq' 
value should be ‘EVERY MONTH END.' 

Contract's 'Int Amortization Freq value should 
be EVERY MONTH END 

'Amortize Balance Type' is 'RENT'. 

[New method is allowed only for Rent] 

Allowed only for RENT Amortization balance 
type should 

Servicing Changes 

Introduced a new field 'Amortization Rate' under Servicing > Customer Service > Account Details 
> Contract Information & Account Details. 
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Batch Job Changes 

When the system executes the 'SET-TAM → TAMPRC_BJ_100_01 (AMORTIZATION 
TRANSACTIONS PROCESSING) batch, and if Amortize Balance Type = Rent + Amortization 
Method = Scheduled Based (Month End) + Int Amortization Freq = EVERY MONTH END→ then 
the behavior as follows 

 If the account is created during the month, the system calculates the amortization until 
month-end. 

 Amortization will happen for the whole month, on month end date from the subsequent 
months. 
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 If the bill is generated during the month, the system amortizes the interest to create 
an amortization entry. 

 The revenue will consistently be recognized monthly, regardless of the payment 
frequency. 

 The revenue calculation is based on the 'Base method' like 30/360 etc., (Existing 
behaviour). 

 In amortization derivation, the system will use the Amortization Rate value 

 Illustration: 

Lease 

Amort_Entries_New.xlsx
 

Example: 

 Accrual accounting is the same as the ‘Advance/Arrears’ method. 

 In the attached excel, the 1st bill was raised on the 15th of November 2018. 

 Interest accrual happens for 16 days for the month of Nov from 15th Nov to 30th Nov 
2018. 

 Subsequently, interest accrual entry would be posted only at month-end for GL handover, 
i.e., on 31st Dec 2018 and so on. 

 Here, system amortizes interest on the bill date and month-end. 

Note: Currently, the system supports only the base method = 30/360 

2.13.3 Seed Data 

Refer ‘Appendix: Seed Data’ chapter. 

 

  

https://docs.oracle.com/cd/F53373_01/pdf/refdocs/ofsll_release_notes_attachments/Lease_Amortized_Entries.xlsx
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2.14 External System Data Processing 

2.14.1 Overview 

Many external systems will use OFSLL data for their processing. Hence, system is required to be 
enhance to generate an outbound file with the necessary data for these external systems. 

Once the external system processes OFSLL data, OFSLL system receives multiple actions [like 
Call Activity, Transaction Posting, Update User Defined Fields & post Comments] data from any 
external system and need to perform the same on OFSLL. 

Following actions are supported in this release: 

 Account Comment Posting 

 Account User Defined Fields update 

 

2.14.2 Description 

Batch Job changes 

Introduced a new batch IRTPRC_BJ_100_01 - INCOMING FILE PROCESSING under the new 
job set SET-RTP  REAL-TIME PROCESSING 

 Once the data is loaded in the inbound_requests and inbound_request_details Table 
with the status ‘R’, the above batch job reads the data and process it according to the 
action, then change the status to ‘P’ or ‘F’. 

 If there are any issues with the data (data type, business validations, access issues), the 
User can see the errors in job results.  

 Populating the data into these Tables are using scripts. A sample script is provided 
below: 

 

Note: 

https://docs.oracle.com/cd/F53373_01/pdf/refdocs/ofsll_release_notes_attachments/RTP_testing_scripts.sql.txt
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 There is no input file provided in this release to load the data into inbound_requests and 
inbound_request_details Tables 

 Only Update User Defined Fields & post Comments actions are supported in this release. 

 Outgoing file generation (1) is also not part of this release. 

2.14.3 Seed Data 

Refer ‘Appendix: Seed Data’ chapter. 
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2.15 Agreement Number Enhancement 

2.15.1 Overview 

In Telco financing accounts are grouped under an agreement # and system is enhanced to do 
following activities on those accounts. 

 Provided an ability to post monetary transaction on accounts which are having same 
agreement #. 

 Search accounts with Agreement #. 

 Filter accounts based on selected Agreement number on UI in Servicing. 

2.15.2 Description 

Origination Impact: 

A new header section "Agreement Details" with following field is added in Origination > Contract 
and Servicing > Conversion Accounts after Statement Section. 

 These field are propagated to servicing as part of funding. 

 The following field is added to below web services. 

 GET Application Entry 

 Application Search 

 Following fields are added in API process. 

Field Name Data Type Field Type Mandatory Default Comments 

Agreement # VARCHAR Text Field N 

  

Account Onboarding/Servicing Impact: 

 A new section “Agreement Details” as part of Account Onboarding (Existing and New) is 
added under “Contract” section. 

 This section consists “Agreement #” field. 

 Provided an ability to pass the External agreement number (or) Auto generated by the 
system. 

 Added a new system parameter “AUTO GENERATE AGREEMENT NUMBER FOR 
ACCOUNT ONBOARDING” to control this behavior. 

 If this parameter is set to Y, system generates the Agreement number. 

 If this parameter is set to N, system accepts the external agreement number provided 
in Account onboarding payload. 

 "Agreement Number" tag is used to pass the external agreement number. In this case 
expectation is "Auto generate agreement number" parameter should be N. 

 "Agreement Number" is used as an identifier to validate the contract details and which 
accounts should get same "Agreement number" in case of "Auto generate agreement 
number" system parameter is set to Y. 

Edits: 

 If two or more accounts are having same agreement number then those accounts should 
have same Master Account # or Master Account Xref #. 
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 If two or more accounts are having same agreement number then those accounts should 
have same contract details like (Due Day, Billing Cycle). 

 If two or more accounts are having same agreement number then those accounts should 
have same product type and funding type. 

Following filed is added in Customer Service > Account Details and Customer Service > Account 
Details >Contract information screens under a new "Agreement Details" section. 

 Agreement Number 

Once the accounts are funded "Agreement details" populated in following screens which are 
provided in account onboarding. 

 Customer Service > Account Details. 

 Customer Service > Account Details >Contract information. 

Added a new maintenance Non-Monetary transaction with flowing parameters to Add / Update / 
Remove the Agreement Details in Customer Service > Account Details. 

 If the Agreement # is not provided update the value with NULL. 

Parameter Data Type Required Display Sort 

Txn Date Date Y Y 0 

Agreement # VARCHAR N Y 1 

 This transaction updates Agreement # field in Customer Service >Account details and 
Customer Service >Account Details >Contract Information. 

A new transaction parameter "PROCESS SAME AGREEMENT NUMBER ACCOUNTS" is added 
to following transaction. 

RESCISSION ACCOUNT 

 Following process happens when the transaction is posted with above parameter in 
combination with "PROCESS MASTER ASSOCIATED ACCOUNTS" and "Process Same 
Sales Order Accounts". 

PROCESS 
MASTER 
ASSOCIATED 
ACCOUNTS 

Process 
Same 
Sales 
Order 
Accounts 

Process 
Same 
Agreement 
Number 
Accounts 

Priority 

N N Y  This transaction will be posted to 
accounts which are having same 
agreement number 

 If there is no Agreement # found on 
account where this transaction is 
posting, system gives an error message 
saying "No Agreement # found for 
Processing". 
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PROCESS 
MASTER 
ASSOCIATED 
ACCOUNTS 

Process 
Same 
Sales 
Order 
Accounts 

Process 
Same 
Agreement 
Number 
Accounts 

Priority 

Y Y Y Process the transaction on Accounts based 
on Process Master Associated Accounts 
parameter and ignore the Process Same 
Sales Order Accounts and Process Same 
Agreement # Accounts parameter 

Y N N Process the transaction on Accounts based 
on Process Master Associated Accounts 
parameter 

Y Y N Process the transaction on Accounts based 
on Process Master Associated Accounts 
parameter and ignore the Process Same 
Sales Order Accounts parameter 

Y N Y Process the transaction on Accounts based 
on Process Master Associated Accounts 
parameter and ignore the Process Same 
Agreement # Accounts parameter 

N Y N Process the transaction on Accounts based 
on the Process Same Sales Order Accounts 
parameter 

A new dropdown “Agreement number” is added next to Associated Accounts radio button in 
Customer Service > Account (s). 

 This dropdown shows the unique "Agreement numbers" present in selected associated 
accounts. 

 This drop down filters the accounts that belong to selected “Agreement number”. (This 
way we can show the BAN > Agreement > Accounts view) 

 This dropdown is enabled only when the associated accounts radio button is selected. 

 



                                                                              2-36 

Added a new dropdown to show the “Agreement numbers” in Customer Service > Associated 
Accounts. 

 This dropdown shows the unique "Agreement numbers" present in selected Product Type 
radio button. 

 This drop down filters the accounts belong to selected “Agreement number” and existing 
selected radio button combination. 

 

2.15.3 Seed Data 

Refer ‘Appendix: Seed Data’ chapter. 
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2.16 Asset Attributes 

2.16.1 Overview 

New asset attributes are added in OFSLL for Vehicle and Other Collateral types to capture the 
Exchange Indicator, shipment date and asset block indicator. 

2.16.2 Description 

Following new fields are added in following screens for Vehicle and Household goods and Other 
collateral. 

 Servicing / Collections > Collateral > header block 

 Servicing > Collateral Management >Collateral Details 

 Conversion Accounts >Collateral (fields are added below address section) 

Filed Name Field Type Default Values Mandatory(Y/N) Comments 

Exchange 
Indicator 

Check Box NA N Device exchange 
indicator (Y if device is 
exchanged) will be 
populated by OFSLL. 

Shipment 
Date 

Date NA N Shipment date of asset. 

Asset Block 
Indicator 

Check Box NA N Used for IMEI Block/ 
Unblock functionality in 
Telco industries. In case 
of cancellation, Telcos 
don’t want the customer 
to use the asset through 
any other service 
provider. 

Other Collaterals: 
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Vehicle collaterals: 

 

Collateral Management: 

 

2.16.3 Web Service Changes 

Above 3 fields are added as part of the below rest services: 

 Asset Fetch Service 

 Asset Create Service 

 Asset Update Service 
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 Account Boarding web service – Both for Async Flow and existing account boarding 
service 

2.16.4 File Upload Changes 

Above 3 fields are added as part of the below file uploads: 

 Asset File uploads (For All Operations) 

2.16.5 Conversion Changes 

 Above 3 fields are added to the conversion screen also.  

 Conversion Accounts >Collateral (fields are added below address section) 

 

2.16.6 Transaction Change 

All the new 3 parameters are added to the Asset Maintenance transaction. 

Parameter 
Name 

Parameter 
Type 

LOV values Default 
Values 

Displayed 
(Y/N) 

Mandatory 
(Y/N) 

Comments 

Exchange 
Indicator 

LOV YES_NO_CD No Y N  

Shipment 
Date 

Date NA NA Y N  

Asset Block 
Indicator 

LOV YES_NO_CD No Y N  

Identification 
Number 

Number NA NA Y N  
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2.16.7 Seed Data 

Refer ‘Appendix: Seed Data’ chapter. 
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2.17 Webhook Support for OBRH 

2.17.1 Overview 

Oracle Banking Routing Hub [OBRH] is used to Authenticate, Invoke and Route request from 
Source to Destination using SOAP/Rest Api.  

As part of this enhancement, OFSLL Webhook framework is enhanced to integrate with OBRH. 

 

 

2.17.2 Description 

 To send/receive data between systems, Request/Response entities are used. System 
allows to send Header/Body details with each Request/Response. 

 For data transfer, typically body details are defined in XML/JSON. Headers are key value 
pairs some are standardized and other are very specific to an implementation 

  

 OFSLL Webhook is used to send event outcome data to external system. OBRH is a new 
endpoint that can receive and process Event data payload from OFSLL. 
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 To register new OBRH interface, OFSLL has undergone below changes: 

 A new authentication mode Oracle Banking Routing Hub is added 

 Before this release below authentication attributes were hardcoded for OAuth2.0 
Authentication mode. These are converted to configuration. Existing customer 
should update values accordingly. These are applicable for Oracle Banking Routing 
Hub and OAuth2.0 Authentication mode 

 

 

Attribute Description 

Response Token 
Key 

This is the key name of Authentication Reponses Header used to identify 
token value that will be used as input for sub sequent calls. 

Before this release system was defaulting to access_token. If not 
provided, system will default to access_token. 
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Request 
Authorization 
Header Prefix 

This is the prefix to be added to Request Authorization Header based on 
token generation mechanism like [Basic, Bearer, JWT etc...] 

Before this release system was defaulting to Bearer. If not provided, 
system will default to Bearer. 

 

 To connect OBRH, OFSLL needs to send addition Authentication and Request Header. 
To support this a new tab Authentication Attributes has be added. 

 

Filed Name Field Type Default Values Mandatory(Y/N) Comments 

Attribute Type LOV NA Y 

Used to record HTTP 
header type: 
1. TOKEN REQUEST 

HEADER: Used to 
add Authentication 
request header 
details 

2. REQUEST 
HEADER: Used to 
add Request header 
details 

Attribute Key Text Field NA Y 

Used to capture HTTP 
header key 

Attribute Value Text Field NA Y 

Used to capture HTTP 
header value 

Enabled Checkbox N Y 

Used to enable/disable 
HTTP header 

Some example for OBRH Headers 

Token Request Headers 

 appId 

Request Headers 

 entityId 

 appId 
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 branchCode 

 userId 

 SERVICE-CONSUMER 

 SERVICE-CONSUMER-SERVICE 

Note: OBRH currently does not support return of customizing HTTP header [X-Hmac] because 
of which enable of Verified indicator using Test button cannot be done. Verification functionality 
should be done manually/via script and needs to be automated using OBRH once new feature of 
customizing HTTP header is enabled. 

2.17.3 Seed Data 

Refer ‘Appendix: Seed Data’ chapter. 
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2.18 Sales Order Number Enhancement 

2.18.1 Overview 

Provided an ability to record Sales Order number for Servicing Accounts that are originated from 
different ERP systems. A single Sales Order request may contain multiple Accounts. 

As part of this requirement, system is enhanced to perform following activities 

 A new Non-Monetary transaction to update Sales Order Number. 

 Ability to post Monetary and Non-Monetary transaction for all accounts created using 
same Sales Order number. 

 Search Accounts bases on the Sales Order Number. 

2.18.2 Description 

Origination Impact: 

A new column is introduced in Application table in Origination to record Sales Order Number. 

 This column supports Alpha-Numeric with 80 characters. 

 This field can accept null or blank and will be propagated to Account once provided. 

 Same column [parameter(salesordernumber) - Description (Account Sales Order 
Number)] is introduced in below WS. 

 Application Entry [GET, PUT, POST] 

 Application Search 

Field Name Type Mandatory (Y/N) Comments 

Sales Order Number Text N  

Origination 

 

Customer Service: 

A new columns introduced in Account table to record Sales Order Number. 

 This column supports Alpha-Numeric with 80 characters. 

 For a single Sales Order Number, OFSLL supports creating multiple accounts 
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 In below Example 1, OFSLL supports creating [Master Acc1, Loan1, Loan2 and Loan3] 
and [Loan4] under one Sales Order Number. 

 OFSLL can associate for all accounts under Master or directly account without 
master. 

 

 In below Example 2, OFSLL is associating Sales Order Number at associate 
accounts like [Loan 1,2,3,4 and Lease2] and not Master Account. 

 

 Conversion and Account on-boarding WS enhanced to record Sales Order Number. 

 This column added in User Defined Table to Search Account using Sales Order 

Number. 

 User Defined Table [SEARCH_ACC_ACCOUNTS] 

 Description [SALES ORDER NUMBER] 

 A new search parameter [parameter (salesordernumber) - Description (Account Sales 
Order Number)] added into existing Account Search Service. 
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 This enables external interfaces to fetch accounts based on Sales Order Number. 

 Account Details WS Response updated to include Sale Order Number as Output 
Parameter. 

 This value displayed in Account Details 

Conversion: 

 

Customer Service: 

 

A new transaction parameter "PROCESS SAME SALES ORDER NBR ACCOUNTS" added to 
below transactions. 

 Default value of this parameter is N and Display is Y. 

 Txn Details 

 DDCHANGE [DUE DATE CHANGE] 

 DDCHANGE_OVERRIDE [DUE DATE CHANGE OVERRIDE] 

 ACC_RESCISSION [RESCISSION ACCOUNT] 

 EXTENSION[EXTENSION] 

 EXTENSION_OVERRIDE[EXTENSION OVERRIDE] 

 ACTIVE[ACTIVE] 

 CHGOFF [CHARGED OFF] 

 This parameter will allow current transaction to be posted on all the accounts with same 
Sales Order Number. 
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 If Sales Order# is BLANK/NULL on the account with "PROCESS SAME SALES 
ORDER NBR ACCOUNTS" =Y, then system will raise error Sale Order# Not Found 
for Processing 

 On any account, if the transaction is unsuccessful, System displays the error 
message in the Transaction details with Account Number creating issue. 

 If transaction is reversed on any of the account, Reversal is only applicable for 
individual account. 

 Below is the expected transaction behaviour if posted with different Account 
Hierarchy 

 Identify all accounts that are of valid status [Must not include Charged-off, 
Closed, Void] for the given Sales Order Number. Only these accounts will be 
considered for processing below. 

 If transaction is posted on Master Account with valid Sales Order# and 
Process Sales Order# flag = Y then system will post on current master account 
and all associated accounts with matching Sales Order# 

 If transaction is posted on Non-Master with valid Sales Order# and Process 
Sales Order# flag = Y then system will post on all accounts [including Master 
Account - if Sales Order# matched] with matching Sales Order# 

 If transaction fails on any selected account. System will reverse all the 
transactions. 

 If user provides Process Master Associated Accounts = Y then system ignores 
Process Sales Order# Txn parameter. 

 Similarly, OFSLL will consider Process Sales Order# as precedency over 
Process Agreement # in Txn parameter. 

PROCESS 
MASTER 
ASSOCIATED 
ACCOUNTS 

Process 
Same Sales 
Order 
Accounts 

Process Same 
Agreement 
Number 
Accounts 

Priority 

N N Y This transaction should be posted 
to accounts which are having 
same agreement number 

If there is no Agreement # found 
on account where this transaction 
is posting, system should give an 
error message saying "No 
Agreement # found for 
Processing". 

Y Y Y Process the transaction on 
Accounts based on Process 
Master Associated Accounts 
parameter and ignore the Process 
Same Sales Order Accounts and 
Process Same Agreement # 
Accounts parameter 
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PROCESS 
MASTER 
ASSOCIATED 
ACCOUNTS 

Process 
Same Sales 
Order 
Accounts 

Process Same 
Agreement 
Number 
Accounts 

Priority 

Y N N Process the transaction on 
Accounts based on Process 
Master Associated Accounts 
parameter 

Y Y N Process the transaction on 
Accounts based on Process 
Master Associated Accounts 
parameter and ignore the Process 
Same Sales Order Accounts 
parameter 

Y N Y Process the transaction on 
Accounts based on Process 
Master Associated Accounts 
parameter and ignore the Process 
Same Agreement # Accounts 
parameter 

N Y N Process the transaction on 
Accounts based on the Process 
Same Sales Order Accounts 
parameter. 

A new transaction "SALE ORDER MAINTENANCE" introduced to update/remove sales order 
number 

This transaction accepts below parameters: 

 To support add/remove Sales Order Number. 

 If not Sales order # not provided system will update existing value to null. 

Parameter Code Default Sort Display  Required 

SALES ORDER NBR  1 Y  N 

TXN DATE  0 Y Y 

Validations: 

 Generic Non-Monetary Transaction Validations like TXN Date etc... Are added. 

 Cannot provide value greater than 80 character.  
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 "Invalid Sales Order Number", Error should be displayed. 

2.18.3 Seed Data 

Refer ‘Appendix: Seed Data’ chapter. 
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2.19 New Condition – (NO ACTIVE CONDITION) Enhancement 

2.19.1 Overview 

Provided an ability to queue the accounts which don’t have any active conditions. 

2.19.2 Description 

 A new condition “NO ACTIVE CONDITION” is added in ACC_CONDITION_CD. 

 Provided an ability to create a queue based on above condition. 

 This condition is posted on accounts as part of following process, if there is no active 
condition available on account. 

 Funding Process (UI) 

 Account Onboarding 

 Conversion Process 

 As part of servicing if any condition posted on account, system automatically removes 
this “NO ACTIVE CONDITION”. 

 User is not allowed to either POST or CLOSE this condition manually. System will only 
POST or CLOSE this Condition on the Account if not active condition available on 
account. 

2.19.3 Seed Data 

Refer ‘Appendix: Seed Data’ chapter. 
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3. Appendix: Seed Data 

Seed data for all the impacted modules against specific enhancement is available in the below 
attached document. 

Seed_Data_14.12.xlsx

 

To view, you can either click on the icon or open from attached documents in left menu. 

 

https://docs.oracle.com/cd/F53373_01/pdf/refdocs/ofsll_release_notes_attachments/Seed_Data.xlsx
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4. Patches and Bugs 

Bug Id Bug Description Fix Description 

NA NA NA 
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5. Security Fixes 

-NA- 

 



                                                                              6-1 

6. Limitations and Open issues 

-NA- 
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7. Components of the Software 

7.1 Documents accompanying the software 

The various documents accompanying the software are as follows: 

 Patch Release Notes 

 Patch Installation Guide 

 Installer Kit 

 User Manuals and Installation manuals - These can be accessed from the link 
30https://docs.oracle.com/cd/F53373_01/index.htm  

7.2 Software Components 

Software Components of this patch release are as follows: 

 Core 

 UI Components Ear file (JSF, XML, XLF, JSFF) 

 Stored Procedures (Packages, Views, Java Stored procedures) 

 Reporting Components(Data models(xdm), Reports(xdo, rtf)) 

 BIP / canned reports 

 Interface 

 Stored Procedures (Packages, Views, Types) 

 The WSDL files for the service supported 

 XSD Structure (dictionary) for the web service 

 Configuration files for the web service 

 Java classes for the web service 

 The service documents – describing the services 

 Extensibility Document – Describes customization for the services. 

 Installation utilities 

 Script based installation for Database components 

 Installation documents for Database, UI, Web services 

 

 

https://docs.oracle.com/cd/F53373_01/index.htm
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8. Annexure – A: Environment Details 

Component 
Deployment 
option 

Machine 
Operating 
System 

Software Version 

Oracle 
Financial 
Services 
Lending and 
Leasing 

Centralized 

Application 
server 

Oracle 
Enterprise 
Linux 6.7+ 
& 7.0 (64 
Bit) and 
Sun 
SPARC 
with Oracle 
Solaris 11 
(64 Bit) 

Oracle WebLogic 
Enterprise 
Edition(Fusion 
Middleware 
Infrastructure installer 
– includes ADF and 
RCU) 

12.2.1.4.0 

Oracle JDK 1.8.0_301 

Application 
Development 
Framework 

12.2.1.4.0 

Database 
Server 

Oracle Database 
Enterprise Edition** 

19.12.0.0.0 

Reporting 
Server 

Oracle Analytics 
Publisher 

5.9.0 

Client 
Machines 

Windows 
10 (Patch 
Version 
1703) 

Microsoft Edge 
(64 Bit) 

90.0.818.5
6 (Official 
Build) 

Mozilla Firefox 
(32 Bit) 

78.10.1esr 

Google Chrome 
(64 Bit) 

90.0.4430.
93 (Official 
Build) 

Mac OS X Apple Safari 
(64 Bit) 

13.1 

** Note: Organizations must evaluate their needs for Oracle Partitioning License option. 
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9. Annexure – B: Third Party Software Details 

For information on Third Party Software Details, refer to Licensing guide available in OTN library 
– https://docs.oracle.com/cd/F53373_01/pdf/refdocs/Licensing_Guide.pdf  

 

 

https://docs.oracle.com/cd/F53373_01/pdf/refdocs/Licensing_Guide.pdf
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